
 

Microsoft Dynamics® GP
Monetary Correction of Inventory



Copyright Copyright © 2010 Microsoft. All rights reserved.

Limitation of liability This document is provided “as-is”. Information and views expressed in this document, including 
URL and other Internet Web site references, may change without notice. You bear the risk of using 
it.

Some examples depicted herein are provided for illustration only and are fictitious. No real 
association or connection is intended or should be inferred.

Intellectual property This document does not provide you with any legal rights to any intellectual property in any 
Microsoft product.

You may copy and use this document for your internal, reference purposes.

Trademarks Microsoft and Microsoft Dynamics are trademarks of the Microsoft group of companies. FairCom 
and c-tree Plus are trademarks of FairCom Corporation and are registered in the United States 
and other countries.

All other trademarks are property of their respective owners.

Warranty disclaimer Microsoft Corporation disclaims any warranty regarding the sample code contained in this 
documentation, including the warranties of merchantability and fitness for a particular purpose.

License agreement Use of this product is covered by a license agreement provided with the software product. If you 
have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 
800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date May 2010



M O N E T A R Y C O R R E C T I O N O F I N V E N T O R Y i

Contents
Introduction ............................................................................................................................................... 1

What’s in this manual...................................................................................................................................1

Symbols and conventions ............................................................................................................................2

Resources available from the Help menu..................................................................................................2

Send us your documentation comments ...................................................................................................4

Chapter 1: Setup ................................................................................................................................... 5
Defining the purchasing currency..............................................................................................................5

Assigning the purchasing currency to inventory items ..........................................................................6

Defining the default correction currency and account ............................................................................6

Assigning the default currency to items....................................................................................................7

Designating the excluded warehouses ......................................................................................................8

Designating the special classes for monetary correction ........................................................................8

Forcing the correction parameters..............................................................................................................9

Updating the currency correction percentage ..........................................................................................9

Selecting transactions for currency correction........................................................................................10

Chapter 2: Routines and reports ......................................................................................... 13
Understanding the currency correction process.....................................................................................13

Correcting the cost of inventory ...............................................................................................................13

Calculating the currency correction and posting adjustments.............................................................14

Posting the currency correction ................................................................................................................15

Generating reports ......................................................................................................................................15

Glossary ...................................................................................................................................................... 17

Index .............................................................................................................................................................. 19



ii M O N E T A R Y C O R R E C T I O N O F I N V E N T O R Y



M O N E T A R Y C O R R E C T I O N O F I N V E N T O R Y 1

Introduction
Monetary Correction of Inventory allows you to revalue the inventory based on the 
price index given by the legal authorities. These revaluations will reflect the change 
in the value of an item due to the correction. You can set up and assign purchasing 
currencies to the items to calculate the corrections. You can also generate reports for 
all the items that have been revalued.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Monetary Correction of Inventory, and how it integrates with the 
Microsoft Dynamics GP system.

To make best use of Monetary Correction of Inventory, you should be familiar with 
systemwide features described in the System User’s Guide, the System Setup 
Guide, and the System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

The manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to set up monetary correction for inventory 
so that it meets the needs of your business. You can set up and assign a 
purchase currency to inventory items.

• Chapter 2, “Routines and reports,” describes the various processes you must 
follow to perform the monetary correction of inventory for a specified period. 
You can print reports for the monetary correction you have performed.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Use this information to complete the setups required to perform the monetary 
correction of inventory. This includes defining the purchasing currencies for items 
and updating the currency correction table with the correction values specified by 
the legal authorities. You can also assign a default currency to items that do not 
have a purchasing currency.

When you set up Monetary Correction of Inventory, you can open each setup 
window and enter information, or you can use the Setup Checklist window 
(Microsoft Dynamics GP menu >> Tools >> Setup >> Setup Checklist) to guide you 
through the setup process. See your System Setup Guide (Help >> Contents >> 
select Setting up the System) for more information about the Setup Checklist 
window.

This information is divided into the following sections:

• Defining the purchasing currency
• Assigning the purchasing currency to inventory items
• Defining the default correction currency and account
• Assigning the default currency to items
• Designating the excluded warehouses
• Designating the special classes for monetary correction
• Forcing the correction parameters
• Updating the currency correction percentage
• Selecting transactions for currency correction

Defining the purchasing currency

Use the Define/Update Purchase Currency window to define the purchasing 
currency for items and the percentage for monetary corrections. This percentage 
should correspond to that specified by the legal authorities from time to time. The 
monetary correction is performed based on either the Greater Value or the Last 
Purchase Value of the items. The Greater Value is the highest purchase price paid for 
an item during the fiscal year. The last purchase value is the price at which the last 
purchase for the item was made in the fiscal period.

To define the purchasing currency:
1. Open the Define/Update Purchase Currency window.

(Cards >> Inventory >> Define/Update Purchase Currency)

2. Enter a Currency Code.

3. Enter a Description for the currency code you are setting up.
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4. Enter the percentage of currency correction specified by the legal authorities for 
items that had no purchases entered during the year.

5. Enter the percentage of currency correction for items that had purchases 
entered during the first half of the year, but not during the second half. This is 
specified by the authorities.

6. Choose whether the monetary correction will be performed on the Last 
Purchase Value, or on the Greater Value of each item.

7. Choose Save to save the currency code details you have entered.

8. Choose Clear to clear, or choose Delete to delete the currency code details 
displayed in the window.

Assigning the purchasing currency to inventory items

Use the Assign Purchase Currency to Specific Items window to assign a purchasing 
currency to specific inventory items.

To assign the purchasing currency to inventory items:
1. Open the Assign Purchase Currency to Specific Items window.

(Cards >> Inventory >> Assign Purchase Currency to Items)

2. Enter or select the Item Code to which to assign the purchasing currency.

3. The Description field displays the description for the selected item.

4. Enter or select the currency code to be assigned to the item code.

5. The Currency Description, the Monetary Correction percentage, and the 
Correction Mode fields display the values for the selected currency code that 
you have set up in the Define/Update Purchase Currency window. You cannot 
change these values. Refer to Defining the purchasing currency on page 5 for more 
information.

6. Choose Save to save the item and currency code combination you have set up.

7. Choose Clear to clear, or Delete to delete the values displayed in the window.

Defining the default correction currency and account

You can select the default currency to perform monetary corrections for items that 
do not have a specific purchasing currency assigned to them and assign a default 
account to update the currency correction. You must also set up the inventory 
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clearing account and the monetary correction clearing account in this window. 
These accounts are used to hold the monetary correction value before the correction 
is posted. Refer to Assigning the default currency to items on page 7 for more 
information.

To define the default correction currency and account:
1. Open the Define Default Currency and Account window.

(Cards >> Inventory >> Default Currency and Account)

2. Enter or select the currency in the Default Currency field.

3. Enter or select the currency correction account. This account is updated with the 
difference during currency correction.

4. Enter or select an Inventory Clearing account. This account is updated with the 
inventory cost amount for the negative and positive adjustments that are 
created during the monetary correction process.

5. Enter or select a Monetary Correction Clearing account. This account is updated 
with the inventory cost amount for the negative and positive adjustments that 
are created during the monetary correction process.

6. Choose Save to save your settings or Clear to clear the values entered.

Assigning the default currency to items

Use the Apply Default Currency to Items window to assign the default currency to 
inventory items that do not have a specific purchasing currency assigned to them. 
You must have already set up the default currency in the Define Default Currency 
and Account window. Refer to Defining the default correction currency and account on 
page 6 for more information.

To assign the default currency to items:
1. Open the Apply Default Currency to Items window.

(Cards >> Inventory >> Apply Default Curr. to Items)

2. Choose Process to assign the default currency to inventory items.



C H A P T E R  1    S E T U P  

8 M O N E T A R Y C O R R E C T I O N O F I N V E N T O R Y

Designating the excluded warehouses

You can select the warehouses to exclude while determining the base reference cost 
for the monetary correction. The companies must have a legal approval to exclude 
the warehouses.

To designate the excluded warehouses:
1. Open the Designate Excluded Warehouses window.

(Cards >> Inventory >> Designate Excluded Warehouses)

2. Select a warehouse code that you want to exclude from the monetary correction. 
The warehouse name is displayed next to the code. You can select multiple 
warehouses to exclude.

3. Choose Save to save your settings and close the window.

Designating the special classes for monetary 
correction

Use the Designate Special Type window to specify the type of monetary correction 
that applies to an inventory class. The companies must have legal acceptance to 
designate these special classes for currency correction.

To designate the special classes for monetary correction:
1. Open the Designate Special Type window.

(Cards >> Inventory >> Designate Special Types)

2. Select a Type Code. The name for the code is displayed in the Type Name field.



M O N E T A R Y C O R R E C T I O N O F I N V E N T O R Y 9

C H A P T E R  1    S E T U P

3. Select the currency correction method to be applied to the inventory class. This 
correction method will be applied to all the items belonging to that inventory 
class.

Normal Process Select this option to process the inventory class as per the 
purchasing currency code assigned to it.

Exclude from CC Select this option to exclude all items in the class from the 
monetary correction process.

Correct as Fixed Asset Select this option to consider the inventory classes 
as a fixed asset. The monetary correction for such inventory classes will be 
calculated according to the fixed assets monetary correction table. Refer to 
Updating the currency correction percentage on page 9 for more information.

Forcing the correction parameters

Use the Force Currency Corr. Parameters window to specify a different cost per unit 
reference for each item. The Last Activ. Date that you specify in this window is used 
to perform the currency correction based on the percentages defined in the Define/
Update Purchase Currency window. Refer to Defining the purchasing currency on 
page 5 for more information.

To force the correction parameters:
1. Open the Force Currency Corr. Parameters window.

(Cards >> Inventory >> Force Correction Parameters)

2. Enter or select the Item Code. The Description field displays the description for 
the item code.

3. Enter the unit cost reference value in the Cos.Unit. Ref. field.

4. Enter the last active date for considering the currency correction values in the 
Last Activ. Date field.

5. Choose Save to save the values you have entered.

Updating the currency correction percentage

Use the SII Currency Correction window to specify the currency correction 
percentage for inventory items that are treated as fixed assets. You can use this table 
to perform monetary correction of fixed assets if you have not installed the 
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Microsoft Dynamics GP Fixed Assets Management module. You can set up the 
inventory items to be treated as fixed assets in the Designate Special Type window. 
The currency correction percentage for such fixed assets is defined by the legal 
authorities from time to time.

To update the currency correction percentage:
1. Open the SII Currency Correction window.

(Cards >> Inventory >> Fixed Assets Mon. Corr. Perc)

2. Choose New Year to enter a year for which to specify the currency correction 
percentage. Enter the percentage for each month as specified by the legal 
authorities.

3. Select an existing year from the Year list to update the existing currency 
correction percentages.

4. Choose Eliminate Year to delete a year for which you do not want to maintain 
currency correction percentages.

5. Choose Save to save the values you entered, or Cancel to close the window 
without saving the changes.

Selecting transactions for currency correction

Use the Mark Inventory Transactions window to include or exclude transactions 
while calculating the currency correction.
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To select transactions for currency correction:
1. Open the Mark Inventory Transactions window.

(Cards >> Inventory >> Mark Inventory Transactions)

2. Enter or select the Item Code.

3. The Description field displays the description for the item code. The scrolling 
window displays the details for all the transactions for the selected item in the 
current year.

4. Select whether to include or exclude a transaction from the currency correction.

Leaving this field blank will include the transaction for the currency correction.

INIC Select this option to include the transaction for currency correction.

NOCM Select this option to exclude the transaction while determining the 
base reference cost for the monetary correction.

5. Choose Clear to clear the selection.
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Chapter 2: Routines and reports
This part of the documentation includes information about currency correction 
routines and reports. Use this information to understand how the inventory cost is 
calculated and updated. You can generate reports for the currency corrections that 
you have performed.

Monetary Correction of Inventory reports are available in the report list. You can 
select a report in the report list and add it to My Reports for easy access. Refer to the 
Microsoft Dynamics GP documentation for more information.

This information is divided into the following sections:

• Understanding the currency correction process
• Correcting the cost of inventory
• Calculating the currency correction and posting adjustments
• Posting the currency correction
• Generating reports

Understanding the currency correction process

The monetary correction of inventory allows you to change the unit cost of your 
inventory on hand quantities based on the correction index specified by the legal 
authorities. The following validations take place before the process begins:

• The cost is corrected only for those items of type Sales Inventory that have a 
positive on hand quantity.

• The cost is corrected only for the on hand quantity. If you maintain quantities 
other than on hand, such as Returned, Damaged etc., then those quantities are 
not considered for correction.

• You must have posted all saved transactions for the current year before 
processing the monetary correction.

• We recommend that you do not post any transactions for future periods before 
posting the monetary correction. However, if you have posted any receipts for 
future periods, then the cost is corrected for these receipts as well.

Correcting the cost of inventory

Use this information to understand the processes that take place when you run the 
monetary correction.

• Calculate the new unit cost for each inventory item The new cost is 
calculated by applying the appropriate correction percentage based on the 
transactions posted during the year. Refer to Defining the purchasing currency on 
page 5 for more information.

• Post the adjustment entries A negative adjustment entry is posted to reset 
the inventory quantity and value to zero. A positive adjustment entry is then 
posted to reset the inventory quantity to the current on hand quantity, and 
update the inventory cost to the new corrected cost. These entries update the 
inventory clearing account and the monetary correction clearing account. Refer 
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to Calculating the currency correction and posting adjustments on page 14 for more 
information.

• Post the monetary correction This transfers the balance from the 
inventory clearing account to the inventory account for each item or to the site 
segment account, if set up. It also transfers the balance from the monetary 
correction clearing account to the monetary correction account. Refer to Posting 
the currency correction on page 15 for more information.

The unit cost is updated for the total on hand inventory quantity at the time that the 
correction is run. We recommend that you do not post any transactions for future 
periods that will affect your inventory balance before you have posted the monetary 
correction.

Calculating the currency correction and posting 
adjustments

Use the Calculate Currency Correction window to revalue the inventory items. The 
reference cost depends on the transactions posted for the item during the current 
year. You can choose to include adjustment transactions to calculate the reference 
cost. Refer to Defining the purchasing currency on page 5 for more information.

You must have posted all transactions for the current year before running the correction 
process.

To calculate the currency correction and posting 
adjustments:
1. Open the Calculate Currency Correction window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Inventory >> Calculate 
Currency Correction)

2. Enter the date to calculate the currency correction in the Correct to field.

Displays the item IDs and the components being processed in the Article field 
and the Component field respectively.

3. Mark the option Include Adjustments in Reference Cost search, to include the 
adjustment entries while determining the reference cost.
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4. Choose Process to perform the currency correction calculation. You can preview 
the Issue Currency Correction Detail and Summary reports to verify the cost 
calculation. Refer to Generating reports on page 15 for information on viewing 
the report.

The Issue Currency Correction preview reports are only indicative. The actual values 
are updated once you post the adjustment entries.

5. Choose Post Decrease Adjustments to post the negative adjustment entries for 
the items that are valued using the average perpetual method.

6. Choose Post Increase Adjustments to post positive adjustment entries. This 
button is available only if you have posted the decrease adjustment entries.

Posting the currency correction

Use the Currency Correction Posting window to post the currency correction for 
sales inventory type items. Posting the currency correction creates a journal entry 
for the difference between the positive and negative adjustment amounts per item 
per site. The balance from the monetary correction clearing account is transferred to 
the monetary correction account, and the balance from the inventory clearing 
account is transferred proportionately to the respective item account. If you are 
using site segments to maintain accounts per site, then the final variance amount 
updates the posting account based on the segment assigned to the site. When you 
post the currency correction, variance entries are created in the HITB tables to 
ensure accuracy in reporting. The source document code for the variance entries is 
CM.

To post the currency correction:
1. Open the Currency Correction Posting window. 

(Microsoft Dynamics GP menu >> Tools >> Routines >> Inventory >> Post 
Currency Correction)

2. Enter the posting date for the currency correction.

3. Choose Process to post the currency correction and create the distributions for 
the monetary correction variance entries. The Recs Read field displays the 
number of transactions processed.

Generating reports

Use this information to generate detailed and summary reports for the currency 
correction that you have performed. You can also generate a report listing the items 
that could not be resolved through currency correction.
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The Historical Inventory Trial Balance report prints the distribution details for the 
monetary correction clearing account and inventory clearing account for each item, 
site-wise.

The following table lists the paths for the reports that you can generate.

Report Name Path

Issue currency correction 
report Detail

Reports >> Inventory >> Issue Currency Corr. Report >> 
Detail

Issue currency correction 
Report Summary

Reports >> Inventory >> Issue Currency Corr. Report >> 
Summary

Issue Report for 
Unresolvable Items

Reports >> Inventory >> Issue Report for Unresolvable 
Items
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Base Reference Cost

The cost on which to apply the correction 
index.
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Index
A
Apply Default Currency to Items window, 

displaying 7
Assign Purchase Currency to Specific 

Items window, displaying 6

C
Calculate Currency Correction window, 

displaying 14
changes since last release, information 

about 3
correction parameters, forcing 9
cost of inventory items, correcting 13
currency correction

calculating 14
posting 15

Currency Correction Posting window, 
displaying 15

currency correction process, 
understanding 13

current upgrade information, accessing on 
the Web 3

D
default correction currency and account, 

defining 6
default currency to items, assigning 7
Define / Update Purchase Currency 

window, displaying 5
Define Default Currency and Account 

window, displaying 7
Designate Excluded Warehouses window, 

displaying 8
Designate the Special Type window, 

displaying 8
documentation, symbols and conventions 

2

E
excluded warehouses, designating 8

F
fixed assets currency correction 

percentage, updating 9
Force Currency Corr. Parameters window, 

displaying 9

H
help, displaying 2
Help menu, described 2

I
icons, used in manual 2
inventory class

excluding from monetary corrections 
9

treating as fixed assets 9

L
lookup window, displaying 3

M
Mark Inventory Transactions window, 

displaying 11

N
new features, information about 3

P
purchase currency, defining 5
purchase currency to inventory items, 

assigning 6

R
reports, generating 15
required fields, described 3
resources, documentation 2

S
SII Currency Correction window, 

displaying 10
special classes for monetary correction, 

designating 8
symbols, used in manual 2

T
transactions for currency correction, 

selecting 10

U
upgrade information, accessing on the 

Web 3

W
what’s new, accessing 3
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